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Source code and copyright information
This software package contains source code. All source code and related information is sub-
ject to the following notice:

Copyright ©2002-2004 Compoze Software, Inc. All Rights Reserved. 

This program is confidential, proprietary and unpublished property of Compoze Software, 
Inc. It may NOT be copied or distributed in part or in whole on any medium, either elec-
tronic or printed, without the express written consent of Compoze Software, Inc. 

Unpublished - rights reserved under the copyright laws of the United States and other coun-
tries.

Trademarks
This document contains information about Compoze Software, Inc., and is protected by 
copyright, trade secret and other state and federal laws. No part of this document may be 
reproduced in any form or by any means, without the written permission from Compoze 
Software, Inc. 

Java and all Java-based marks are trademarks or registered trademarks of Sun Microsys-
tems, Inc. in the United States and other countries.

All other brands and names are property of their respective owners.

Compoze Software, Inc. is independent of BEA System, Inc., IBM Corporation, Microsoft 
Corporation, and Sun Microsystems, Inc.

Contact information
Compoze Software, Inc.
1200 Liberty Ridge, Suite 110
Wayne, PA 19087 

Telephone: 1.610-862-1104
Toll-free (US only): 1.866.COMPOZE (1.866.266.7693)
Fax: 1.484.527.0232

Web Site: www.compoze.com
Information: info@compoze.com
Sales: sales@compoze.com
Support: support@compoze.com
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About This Document
This guide is intended for portal end users, developers and administrators who are building, 
deploying and using an Enterprise portal. A basic understanding of BEA WebLogic Portal, 
WebLogic Workshop, and Java are assumed.

Prerequisite Software
Setting up the Compoze Portlets assumes the following prerequisite software:

• BEA WebLogic Platform 8.1 with Service Pack 2 or higher
• One of the following:

• Microsoft Exchange 5.5 with Service Pack 4 or higher
• Microsoft Exchange 2000 with Service Pack 1 or higher
• Microsoft Exchange 2003
• Lotus Domino R5.0.11 or higher
• Lotus Domino R6.0.3

Documentation Syntax Conventions
The Windows convention of “\” as a path separator is used wherever necessary. UNIX 
users and users of other operating systems should translate these paths and variables accord-
ingly.

Also, since system software and configurations can vary from one system to another, por-
tions of the command syntax displayed in this document may include sample parameters or 
variables that represent the actual command syntax you would need to enter. These entries 
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Documentation Syntax Conventions
are indicated by parameters in uppercase placed between percent signs (%PARAMETER%), and 
include, but are not limited to the following:

Parameter Definition
%COMPOZE_HOME% The complete directory specification for the Compoze 

Home. This is the directory where Compoze Portlets are 
installed. For example:
c:\Program Files\compoze

%COMPOZE_PORTLETS_HOME% The complete directory specification for the Compoze Port-
lets Home. This is the directory where Compoze Portlets 
are installed. For example:
c:\Program Files\com-
poze\compoze_portlets_bea-2.5\8.1

%COMPOZE_EXCHANGE_SERVICE_HOME% The complete directory specification for the Compoze 
Exchange Service Home. This is the directory where the 
Compoze Exchange Service is installed. For example:
c:\Program Files\compoze\czex

%COMPOZE_DOMINO_SERVICE_HOME% The complete directory specification for the Compoze 
Domino Service Home. This is the directory where the 
Compoze Domino Service is installed. For example:
c:\Program Files\compoze\czdo

%PORTAL_APPLICATION% The complete directory specification for the BEA Applica-
tion that is hosting the Portal Project. For example:
d:\bea81\user_projects\PortalApplication

%PORTAL_PROJECT% The complete directory specification for the BEA Project 
that is hosting the Portal. For example:
d:\bea81\user_projects\PortalApplica-
tion\PortalWebProject

%WL_HOME% The complete directory specification for the BEA Home. 
This is the directory where BEA WebLogic Platform 8.1 is 
installed. For example:
d:\bea81

%JAVA_HOME% The complete directory specification for the Java Develop-
ment Kit. For example:
d:\bea81\jdk141_05
Compoze Portlets Setup Guide v



CHAPTER 1 Introduction
The Compoze Portlets installer copies files for the Compoze Portlets into the appropriate 
folder under your %PORTAL_PROJECT%. This Setup Guide walks you through the steps you 
need to complete the Compoze Portlet setup.

Before you can access data in the Compoze Portlets, a Service must be setup so that you can 
connect to the Groupware System. The Service interacts with the underlying Groupware 
System and provides the data to the Compoze Portlets. Currently, Services exist for 
Microsoft Exchange and Lotus Domino. You only need to setup the service that is applica-
ble to your environment.

Once the required Service is installed and configured properly, the Compoze Portlets can be 
configured to access this Service.

Chapters in this Guide include:

• “Introduction” on page 1-1 (this chapter!)
• “Compoze Exchange Service” on page 2-1
• “Compoze Domino Service” on page 3-1
• “Groupware Portlet” on page 5-1
• “Customizing the Groupware Portlet” on page 6-1
• “Administration Portlet” on page 4-1
• “Manual Installation” on page A-1

Note: When you have finished all of the setup instructions in each of the above chapters, 
open the compoze_portlets_users_guide.pdf file located at 
%COMPOZE_PORTLETS_HOME%\docs for information about using the portlets.
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CHAPTER 2 Compoze Exchange Service
This chapter describes the Compoze Exchange Service architecture, installation and config-
uration and supported platforms.

Getting Started
The following is required in order to install and configure the Compoze Exchange Service:

• Microsoft Exchange Server CD (for CDO and MAPI)
• Windows 2000 Server (with Service Pack 3 or higher) or Windows 2003 Server
• Internet Information Server (IIS)
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Architecture
With the Compoze Portlets, Compoze has implemented a native Windows service which 
exposes Microsoft Exchange 5.5 (and later) functionality. The Compoze Exchange Service 
acts as an intermediary between the BEA WebLogic Portal and Microsoft Exchange.

SOAP Interface

The connectivity between Java and the Compoze Exchange Service is implemented using 
SOAP (Simple Object Access Protocol) version 1.1. SOAP provides a standard means of 
XML based messaging (including RPC, or Remote Procedure Call style messaging) that can 
be used across platforms.

On the Compoze Exchange Service side, IIS is used to handle SOAP communication with 
the client. A component written by Compoze handles requests from the client and sends 
them to another process on the same machine using local RPC. This process isolation 
insures that Exchange communication is not occurring in-process with IIS.

Connectivity to Exchange

Connectivity to Microsoft Exchange is implemented in a Windows service called the Com-
poze Exchange Service. The Compoze Exchange Service runs as a standalone process and 
exposes its functionality via local RPC to other processes in the system (including IIS). 
Compoze Portlets Setup Guide 2-2
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Architecture
When requests come in, they are given a thread out of a thread pool that grows and shrinks 
automatically as necessary. Sessions that have been open for longer than the time-out period 
are automatically closed to avoid holding resources open unnecessarily.

The Compoze Exchange Service is implemented using a combination of MAPI (Messaging 
Application Programming Interface) and CDO (Collaboration Data Objects) therefore CDO 
and MAPI from an Exchange Server CD is a prerequisite of the installation. This is where 
CDO and the MAPI provider for Exchange are obtained.

Network/Firewall Requirements

The Compoze Exchange Service must be located either on the same domain as the 
Exchange server or a trusted domain. Additionally, it must be configured to allow logins 
from the Exchange users who will be accessing their mailboxes. This requirement exists 
because the user logging on to Exchange actually performs a login to the Compoze 
Exchange Service machine in order to obtain a primary access token.

NOTE: It is possible to put the Compoze Exchange Service on the Exchange server itself, 
but be aware of the additional processor and memory burden that will be placed on 
Exchange.

HTTP or HTTPS traffic must be able to pass between the Portal and the Compoze Exchange 
Service. Traversing an HTTP proxy is OK as long as it is able to pass the POST requests 
used by the SOAP protocol. Although a high bandwidth, low-latency connection will 
improve performance, the protocol has been designed to reduce the number of round trips 
made on the network. The amount of bandwidth required will depend on the number of 
users simultaneously using the application. Each user may consume roughly 1K/sec. on 
average, with this number increasingly dramatically if users do a lot of work with large file 
attachments.

MSRPC traffic must be able to pass between the Compoze Exchange Service and Microsoft 
Exchange. MSRPC requires TCP port 135 to be open plus a range of ports above 1024. The 
network connection for this MSRPC traffic must have a low latency (less than 10 millisec-
onds, and preferably a 100 megabit LAN with less then 1 millisecond response times). 
Round trips are made over the network for each MAPI RPC, therefore the Compoze 
Exchange Service machine must be located as close as possible to Exchange on the net-
work.
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Installation and Configuration

Prerequisites
The Compoze Exchange Service must be installed on a clean Windows 2000 (with Service 
Pack 3 or higher) or Windows Server 2003 with IIS. Windows 2000 Professional may be 
used for testing purposes, but it only allows 100 simultaneous socket connections at a time, 
a limit that you will likely run into in production. If you are using a machine which already 
has other software installed on it, proceed at your own risk, however, it MUST not have 
Microsoft Outlook on it or any other product which installs a different version of CDO.

CDO and the MAPI Exchange Service provider are a required prerequisite of the installa-
tion. They may only be obtained using one of the two methods below. You may not install 
CDO using any version of Microsoft Outlook. If you do, it may initially work but Microsoft 
does not support use the dlls that ship with Outlook in server applications, so you may run 
into issues under high server load.

The MAPI Exchange Service Provider and CDO (Collaboration Data Objects) may be 
installed in one of two ways:

Method #1: Installing the Exchange 5.5 Administrator from the Exchange 5.5 
Server CD

1. Insert the Microsoft Exchange 5.5 Server CD. (NOTE: If you are running Exchange 
2000, this 5.5 CD also ships with Exchange 2000 distributions.)

2. Choose “Setup Server and Components”.
3. Choose “Microsoft Exchange Server 5.5”.
4. Choose “Complete / Custom”.
5. Choose “Microsoft Exchange Administrator” only install (un-check all other boxes).
6. Enter the license key.
7. Install Exchange 5.5 Service Pack 4 (http://www.microsoft.com/exchange/downloads/

55/sp4.asp). This should upgrade cdo.dll to version 5.5.2653.12 (may be checked by 
right clicking the dll in Explorer and going to the Version tab).

8. Install the proper CDO patch (available at http://support.microsoft.com/
default.aspx?scid=kb;en-us;818709). This should upgrade cdo.dll to version 
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5.5.2657.55 or later (may be checked by right clicking the dll in Explorer and going to 
the Version tab).
Warning: If you do not perform this step then CDO and the Compoze Exchange 
Service will crash when accessing mailboxes that have been used by Outlook 2003.

Method #2: Installing a Full Exchange Server from the Exchange 5.5, Exchange 
2000 or Exchange 2003 CDs

CDO 1.2.1 is installed with all versions of Exchange 5.5, Exchange 2000 and Exchange 
2003. However, in some cases the cdo.dll that gets installed may not be registered during 
the installation. To be sure that cdo.dll is registered on your Exchange server, perform the 
following steps after Exchange has been installed:

1. Open a command prompt
2. cd to exchsrvr\bin (depends on where you have Exchange installed)
3. Run “regsvr32.exe cdo.dll” to register CDO

Once CDO is registered, upgrade your Exchange server to the latest service pack so that the 
latest CDO is included.

For Exchange 5.5 Only: Follow step 8 on page 2-4 to obtain the latest CDO patches. After 
the installation, you may stop all Microsoft Exchange related services in Administrative 
Tools > Services so that you do not actually use the server itself.

Running the Installer
After installing the Compoze Portlets, an executable called setup_service.exe is placed in 
%COMPOZE_HOME%\service\exchange. Run this executable on the Compoze Exchange Ser-
vice machine. During the installation, you will be prompted to specify the location of two 
important directories:

• MAPI profile directory: This is a directory where temporary MAPI profiles are stored. 
The profiles are small and are deleted when they are no longer in use so it is safe to 
choose a directory on a volume with a couple hundred MB (megabytes) free. This set-
ting will be reflected in the registry key HKEY_LOCAL_MACHINE\Soft-
ware\Microsoft\Windows Messaging Subsystem\ProfileDirectory.

• Attachments directory: This is a directory where attachments are stored temporarily 
while they are transferred from IIS to the Compoze Exchange Service. It is also criti-
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cal that the permissions on the attachments directory be set so that all users have read/
write access to it. The attachment files are deleted when they are no longer in use, 
however attachments can be large, and many users can be creating them at any given 
time. Therefore, it is good practice to point to an attachments directory on a volume 
with 1 gigabyte or more free (depending on how much load your Compoze Exchange 
Service will see).

Assuming you have installed the prerequisites, the installation will install the Compoze 
Exchange Service and register the SOAP component with IIS.

NOTE for Windows 2003/IIS 6.0 Installations: For security reasons, the default configu-
ration for IIS 6.0 does not serve any dynamic content. You must go to Administrative 
Tools > Internet Services Manager > Web Service Extensions and add a “czex-
soap” web service then add c:\Program Files\Common Files\MSSOAP\Bina-
ries\SOAPIS30.dll and the full path to the Compoze Exchange Service install file 
czex_soap.dll (for example c:\Program Files\compoze\czex\bin\czex_soap.dll) to 
the “allow” list. Otherwise, you will get an HTTP 401 (not found) error when trying to con-
nect to the service.

Verifying the Installation
After the Compoze Exchange Service installation, you can verify that it was installed prop-
erly by verifying the following:

1. You should have a directory tree located in c:\Program Files\compoze\czex (or 
wherever you chose to install the Compoze Exchange Service). This is the 
%COMPOZE_EXCHANGE_SERVICE_HOME%.

2. There should be a new service in Administrative Tools > Services called Com-
poze Exchange Service. It should be started.

3. There should be a new IIS virtual root in Administrative Tools > Internet Ser-
vices Manager called czexsoap. In this virtual root should be two files: CzExSoap.WSDL 
and CzExSoap.wsdl.

4. If you are upgrading from a previous installation of Compoze Exchange Service, check 
the version number of %COMPOZE_EXCHANGE_SERVICE_HOME%\bin\czex_soap.dll by 
right clicking the file in Explorer and choosing Properties. If the dll is older than the 
current build, it was not replaced by the installation process because the dll was held by 
IIS. In this case, completely uninstall Compoze Exchange Service, reboot the machine 
then try the installation again.
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Minimal IIS Lockdown Settings
The IIS Lockdown tool is supplied by Microsoft and allows you to protect your IIS server 
by denying access to certain HTTP methods, file extensions, etc. The following IIS Lock-
down wizard walkthrough shows the minimum settings needed for the Compoze Exchange 
Service to run:

1. Select Server Template Screen: Select the template “Other (Server that does not match 
any of the listed roles)”.

2. Internet Services Screen: Enable only “Web service (HTTP)” and click “remove un-
selected services” if you wish.

3. Script Maps Screen: Disable support for all selected script maps.
4. Additional Security Screen: Remove all selected virtual directories from the server. Set 

file permissions to prevent anonymous users from performing these actions- include 
“Running system utilities” and “Writing to Content Directories”. Check “Disable Web 
Distributed Authoring and Versioning (WebDAV)”.

5. URLScan Screen: Check box that says “Install URLScan filter on the server”
6. urlscan.ini file: With UseAllowVerbs=1 set, the AllowVerbs section only needs to 

contain the “POST” verb. With UseAllowExtensions=1 set, the AllowExtensions sec-
tion only needs to contain the extension “.wsdl”.

Logging Information

Logging information for the Compoze Exchange Service and the Microsoft SOAP Toolkit 
is sent to the Windows Event Viewer. In the Application Log you will find information 
about the status of the service (during startup and shutdown), and warnings or errors if 
something goes wrong. The default Application Log size may be too small for your applica-
tion. A minimum log size of around 5MB is recommended. In addition, the setting “Over-
write as Needed” is recommended to insure that no recent events are lost.

If you find that your event logs fill quickly and would like to reduce the amount of informa-
tion logged, make sure that the AuditEnabled and LogComErrors registry entries are set to 
0.
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Maintaining Service Uptime

Windows offers you the ability to enable crash recovery for the service so that you do not 
have to monitor and restart it in the event of a crash. To enable this, go to Control Panel > 
Administrative Tools > Services > Compoze Exchange Service properties. Under 
the Recovery tab, set First Failure, Second Failure and Subsequent Failures to “Restart the 
Service”. You may wish to set the “Restart Service After” time to 0 minutes, so that the ser-
vice restarts immediately. Now, if a failure occurs, the service will automatically restart. 
Note that all existing sessions will be lost, forcing users to log back in again.

In addition to enabling the restart of the service in the event of a crash, you can also set the 
service to automatically terminate at a given interval using the ServiceRestartHours and 
ServiceRestartMaxSessions registry entries. For more information, see “Administration 
Portlet” on page 4-1. As long as the service has been set to restart, Windows will restart the 
service after it has terminated. When this happens, an Error event will be registered in the 
System log of the event viewer to indicate that the service has terminated and restarted.

Performance Settings

There are very few user adjustable performance settings for the Compoze Exchange Ser-
vice. The thread pool and memory heap in the service itself both grow and shrink as needed. 
However, the thread pool size in IIS for SOAP can be adjusted manually using the SOFT-
WARE\Microsoft\MSSOAP\30\SOAPISAP registry entry. By default, it is set to two times the 
number of CPUs plus 1 (for example, 3 for a single CPU machine). You may find that rais-
ing this setting in a production environment to 3 times the number of CPUs plus 1 gives you 
improved concurrency in IIS.

Troubleshooting

The following is for troubleshooting issues with the Compoze Exchange Service. This Ser-
vice is the Groupware Service Provider for the Microsoft Exchange.

Reporting Crash Errors

If you find that the Compoze Exchange Service crashes in your environment and you wish 
to pursue it with Compoze support, there are steps that you can take to help us assist you. 
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Please provide as much of the following information as possible in a single zip file when 
submitting your request:

1. The error-#.txt and error-#.dmp files in the 
%COMPOZE_EXCHANGE_SERVICE_HOME%\bin. These files are created when a service crash 
occurs, and are critical in order for Compoze to resolve a problem.

2. The contents of your Application Log in the Event Viewer. This can be obtained by run-
ning “eventvwr”, right clicking on the Application Log and choosing “Save File As”. 
Save the file in .evt format.

3. What operation was being performed at the time of the crash, and whose mailbox it 
occurred in. This may be difficult information to obtain, but if available it does assist us 
in the debugging process, particularly if you are able to force a crash and give us a series 
of steps to reproduce it.

4. Version information of each of the service components. In Windows explorer, right-
click each of czex_service.exe, czex_soap.dll, czex_util.dll, and cdo.dll and 
select the Version tab. This will aid in matching the supplied debug information with 
the version installed on your system.

In some situations, Compoze may request that you reproduce the problem send a full crash 
dump (much larger than the mini dump). These are the steps to obtain a full crash dump:

1. Run drwtsn32 -i from a command prompt. You should see the message “Dr. Watson 
has been installed as the default debugger”.

2. Run drwtsn32 by itself to configure Dr. Watson. Check the box that says “Dump Sym-
bol Table” and select the number of errors that you wish to save (the defaults are accept-
able).

3. Reproduce the problem and zip up and send the user.dmp and drwtsn32.log files that 
are created to support@compoze.com.

Reporting Problems With Messages

You may find that a particular message or folder is causing you problems with the API or 
service. In this case, it is possible to export the original messages for import at Compoze in 
order to reproduce the problem. To do this:
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1. Open Outlook 2000 or above to the account with the problem messages.
2. Choose File > Import and Export.
3. In the “Import and Export Wizard” screen, choose “Export to a file”.
4. In the “Export to a File” screen, choose “Personal Folder File (.pst)”.
5. In the “Export Personal Folders” screen, choose the folder that you wish to export. It is 

easiest to export an entire folder (such as the calendar folder), but you may also click the 
Filter button and restrict what is exported by date range, subject, attendees, created time, 
etc. Just make sure that the offending messages get included by the filter you have cho-
sen.

After exporting the PST file, please place this in a zip file along with a small readme.txt file 
that explains the problem with the message(s) and any filter that was used for the export in 
step 5. Send this zip file to support@compoze.com.
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CHAPTER 3 Compoze Domino Service
This chapter describes the Compoze Domino Service architecture, installation and configu-
ration and supported platforms.

Getting Started
The following is required in order to install and configure the Compoze Domino Service:

• Lotus Domino R5.0.11 or higher
or

• Lotus Domino R6.0.3
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Architecture
With the Compoze Portlets, Compoze has implemented a native Notes service which 
exposes Lotus Domino mail functionality to Java programs. The Compoze Domino Service 
acts as an intermediary between the BEA WebLogic Portal and Lotus Domino.

Connectivity to Domino

The Compoze Domino Service is implemented using a combination of Notes RPC and 
Notes DSAPI. It runs within Lotus Domino as part of the HTTP task. This is the reason the 
Lotus Domino install is a prerequisite of the installation. This is where Notes RPC and the 
Notes DSAPI filter for Domino are obtained.

Network/Firewall Requirements

The Compoze Domino Service must be located on a machine running Lotus Domino that is 
part of the same Notes Domain and the same Notes Named Network as the Domino server 
to access. It is possible to put the Compoze Domino Service on an existing Domino server, 
but be aware of the additional processor and memory burden that will be placed on Domino.

HTTP traffic must be able to pass between the Compoze Portlets and the Compoze Domino 
Service. Traversing an HTTP proxy is OK as long as it is able to pass the POST requests 
used by the XML protocol. Although a high bandwidth, low-latency connection will 
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improve performance, the protocol has been designed to reduce the number of round trips 
made on the network. The amount of bandwidth required will depend on the number of 
users simultaneously using the application. Each user may consume roughly 1K/sec. on 
average, with this number increasingly dramatically if users do a lot of work with large file 
attachments.

Notes RPC traffic must be able to pass between the Compoze Domino Service and Lotus 
Domino. Notes RPC requires TCP port 1352 to be open. The network connection for this 
Notes RPC traffic must have a low latency (less than 10 milliseconds, and preferably a 100 
megabit LAN with less then 1 millisecond response times). Round trips are made over the 
network for each Notes RPC, therefore the Compoze Domino Service machine must be 
located as close as possible to Domino on the network.

Installation and Configuration

Prerequisites
Before installing the Compoze Domino Service, the following steps must be taken:

1. Uninstall and remove any previous installed version of Compoze Domino Service. This 
will ensure a clean install will occur.

2. For Windows installation, ensure Windows 2000 with Service Pack 4 or higher is 
installed on the server.
For Linux installation, ensure Red Hat 8.0 or higher is installed on the server.

3. Lotus Domino R5.0.11 (or higher) or Domino R6.0.3, with the HTTP Task, is installed 
on the server.

4. The server is registered within the Notes domain.

Running the Installer on Windows
To install the Compoze Domino Service onto Windows, follow these steps:
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1. Start the installer by double-clicking on setup_service.exe. The InstallAnywhere 
screen opens and begins preparing the installation.

2. Read through the introduction and click “Next”. You will be able to exit the installation 
at anytime by clicking “Cancel”. You will also be able to go back a step by clicking 
“Previous” when available.

3. Read through the Compoze license agreement and select an option:
• Selecting “I accept the terms of the License Agreement” will allow you to continue 

with the installation.
• Selecting “I do NOT accept the terms of the License Agreement” will terminate the 

installation.
4. Click “Next”.
5. Select the directory Compoze Domino Service will be installed to. By default, 

%COMPOZE_HOME% is chosen. You may change this by entering the absolute path of the 
directory or by clicking “Choose” and selecting the directory.

6. Click “Next”.
7. Choose the Lotus Domino program directory. On a Domino server the program directory 

is typically C:\Lotus\Domino, unless you installed the program files to a different loca-
tion. You may change this by entering the absolute path of the directory or by clicking 
“Choose” and selecting the directory.

8. Click “Next”. If the specified directory does not contain the Lotus Domino program 
files, an information screen appears stating such. Click “Next” to continue or “Previous” 
to go back and enter a valid Domino program directory.

9. Choose the Lotus Domino data directory. On a Domino server the Domino data direc-
tory is typically C:\Lotus\Domino\Data, unless you installed the data directory to a dif-
ferent location. You may change this by entering the absolute path of the directory or by 
clicking “Choose” and selecting the directory.

10. Click “Next”. If the specified directory is not a valid Domino data directory (i.e. does not 
contain the names.nsf database), an information screen appears stating such. Click 
“Next” to continue or “Previous” to go back and enter a valid Domino data directory.

11. Read the installation summary information before clicking “Install”. The summary will 
contain information such as the installation directory, the amount of disk space required, 
etc.

12. Click “Install” to install the service.
13. Once installation is complete, click “Done”
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Verifying the Windows Installation
To verify Compoze Domino Service was installed, check the following:

• A directory tree located at %COMPOZE_HOME%\domino_service.
• The following files added to %LOTUS_DOMINO_HOME% directory:

cz_xerces-c.dll
czdo.dll
czdo_service.dll

• The following database added to %LOTUS_DOMINO_DATA% directory:
czdo_config.nsf

Running the Installer on Linux
Compoze Portlets on Linux can be installed in two different modes:

• “GUI Mode” on page 3-5
• “Console Mode” on page 3-6

Note: It is critical you be root or have write permission for the directory where you plan to 
install the Compoze Portlets. You must also have write permissions for the Domino server 
directories.

GUI Mode

The installer running in GUI mode will utilize GUI panels and will ask for all necessary 
configuration questions through the graphical panel. You must have the X-Window server 
running on the machine where you are installing the Compoze Portlets. 

To install the Compoze Domino Service on Linux using GUI mode, follow these steps:

1. Start the installer. To start the installer, enter in the following at the command prompt:
prompt> chmod 755 setup.bin
prompt> ./setup.bin

2. Read through the Compoze license agreement and select an option:
• Selecting “I accept the terms of the License Agreement” will allow you to continue 

with the installation.
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• Selecting “I do NOT accept the terms of the License Agreement” will terminate the 
installation.

3. Click “Next”.
4. Select the directory Compoze Domino Service will be installed to. By default, 

%COMPOZE_HOME% is chosen. You may change this by entering the absolute path of the 
directory or by clicking “Choose” and selecting the directory.

5. Click “Next”.
6. Choose the Lotus Domino program directory. On a Domino server the program directory 

is typically /usr/lotus/notes/{version}/{platform} (or $Notes_ExecDirectory), 
unless you installed the program files to a different location. You may change this by 
entering the absolute path of the directory or by clicking “Choose” and selecting the 
directory.

7. Click “Next”. If the specified directory does not contain the Lotus Domino program 
files, an information screen appears stating such. Click “Next” to continue or “Previous” 
to go back and enter a valid Domino program directory.

8. Choose the Lotus Domino data directory. On a Domino server the Domino data direc-
tory is typically /usr/lotus/notesdata, unless you installed the data directory to a dif-
ferent location. You may change this by entering the absolute path of the directory or by 
clicking “Choose” and selecting the directory.

9. Click “Next”. If the specified directory is not a valid Domino data directory (i.e. does not 
contain the names.nsf database), an information screen appears stating such. Click 
“Next” to continue or “Previous” to go back and enter a valid Domino data directory.

10. Read the installation summary information before clicking “Install”. The summary will 
contain information such as the installation directory, the amount of disk space required, 
etc.

11. Click “Install” to install the service.
12. Once installation is complete, click “Done”

Console Mode

The installer running in console mode will not utilize GUI panels (X-Window Server), but 
instead will ask all necessary configuration questions through the command prompt. This is 
best for machines running Lotus Domino Server without an X-Server.

To install the Compoze Domino Service on Linux using the Console mode, follow these 
steps:
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1. Start the installer. To start the installer, enter in the following at the command prompt:
prompt> chmod 755 setup.bin
prompt> ./setup.bin -i console

2. Read through the Compoze license agreement and select an option:
• Entering “Y” accept the license agreement and allow you to continue with the installa-

tion.
• Entering “N” will decline the license agreement and terminate the installation.

3. Press “Enter”.
4. Select the directory Compoze Domino Service will be installed to. By default, 

%COMPOZE_HOME% is chosen. You may change this by entering the absolute path of the 
directory.

5. Press “Enter”.
6. You will be prompted if the selected directory is the correct directory to install the ser-

vice.
• Entering “Y” will accept the directory and continue with the installation.
• Entering “N” will return you to the previous step to select the directory Compoze 

Domino Service will be installed to.
7. Press “Enter”.
8. Choose the Lotus Domino program directory. On a Domino server the program directory 

is typically /usr/lotus/notes/{version}/{platform} (or $Notes_ExecDirectory), 
unless you installed the program files to a different location. You may change this by 
entering the absolute path of the directory.

9. Press “Enter”. If the specified directory does not contain the Lotus Domino program 
files, the console will display information stating such. Press “Enter” to continue or enter 
“Back” to go back and enter a valid Domino program directory.

10. Choose the Lotus Domino data directory. On a Domino server the Domino data direc-
tory is typically /usr/lotus/notesdata, unless you installed the data directory to a dif-
ferent location. You may change this by entering the absolute path of the directory.

11. Press “Enter”. If the specified directory is not a valid Domino data directory (i.e. does 
not contain the names.nsf database), the console will display information stating such. 
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Press “Enter” to continue or enter “Back” to go back and enter a valid Domino data 
directory.

12. Read the installation summary information before pressing “Enter”. The summary will 
contain information such as the installation directory, the amount of disk space required, 
etc.

13. Press “Enter” to install the service.
14. Once installation is complete, press “Enter” to exit.

Verifying the Linux Installation
To verify Compoze Domino Service was installed, check the following:

• A directory tree located at %COMPOZE_HOME%/domino_service.
• The following files added to %LOTUS_DOMINO_HOME% directory:

libxerces-c.so
libczdo.so
libczdo_service.so

• The following database added to %LOTUS_DOMINO_DATA% directory:
czdo_config.nsf
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CHAPTER 4 Administration Portlet
After installation, it is highly recommended that you verify that the Groupware Service Pro-
vider has been set up correctly. An Administration Portlet is included to test the connection 
and to configure the Groupware Service Provider. The Administration Portlet works for 
both Microsoft Exchange and Lotus Domino.

Also, if there are issues with specific BEA WebLogic Portal users, the Administration Port-
let can be used to diagnose the problem and resolve the issue.

Note: Before you begin, the Administration Portlet must be added to a page on your existing 
Portal.

Welcome Page
The starting point of the Administration Portlet is the welcome page. From here, you can 
diagnose your connection to either Exchange or Domino, configure the Compoze Exchange 
Service or Compoze Domino Service or obtain more information about the BEA WebLogic 
Portal User Profile that is being used by the Groupware Portlet. Select the correct option for 
your environment and click the “Start” button to continue. The next page will change 
depending on what option you choose. The rest of this chapter will discuss each possible 
section in more detail.
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Compoze Exchange Service Connection
To verify that you can open a connection to the Compoze Exchange Service and that the 
service can connect to Exchange, use the Exchange Connection Portlet.

Connecting to Exchange via the Compoze Exchange Service
1. Select the Exchange Service Connection option from the Welcome page of the Adminis-

tration Portlet.
2. Enter the required connection information. A detailed description for each parameter is 

listed in the table below.
3. Once the required information is entered, click the “Connect” button.
4. If you can connect successfully, you will be given the option of obtaining more informa-

tion for the mailbox specified by clicking the continue button. This will test common 
calls to the service such as getting the number of messages from the Inbox.

5. Click the “End Diagnosis” button at any time to start over.t

Field Description

Domain the domain of the user that will access the Exchange mailbox

Username the username of the user that will access the Exchange mailbox

Password the password of the user that will access the Exchange mailbox

Exchange Server the name of the Exchange Server as it can be resolved from the 
Compoze Exchange Service machine (may be omitted to test GAL 
lookups, but these must first be configured in the service. For more 
information, see “Global Address List Lookups” on page 4-8.)

Exchange Mailbox the name of a mailbox to connect to (may be omitted to test GAL 
lookups, but these must first be configured in the service- see Global 
Address List lookups section)

Soap Server the hostname of the Compoze Exchange Service machine as it can 
be resolved from the Portal machine
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Compoze Exchange Service Configuration
As a system administrator, you will be able to configure the Compoze Exchange Service. 
The configuration can be performed either manually (on the Compoze Exchange Service 
machine) or by using the Administration Portlet.

Configuring the Compoze Exchange Service
1. Select the Exchange Service Configuration option from the Welcome page of the Com-

poze Administration Portlet.
2. Enter the required Exchange Service URL or host name. This value is the same as the 

Soap Server entered in the ExchangeServiceConnection Portlet.
3. Once the required information is entered, click the “View Configuration” button.
4. If you can connect successfully, you will be given the option of obtaining the current 

configuration information and modifying the settings for the following logical sections:
• General Configuration Parameters
• Global Address List Configuration Parameters
• Logging Configuration Parameters
• IIS Configuration Parameters
• A detailed description for each parameter is listed Manually Configuring the Reg-

istry Entries section below.
5. Configure the information by entering a logical section, modifying the desired data, and 

clicking the “Configure Service Now” button.

Note: Some of the parameters will require a restart of the Compoze Exchange Service or IIS 
to take effect. These parameters are identified in the Portlet.

Manually Configuring the Registry Entries

To manually configure the Compoze Exchange Service, you will need to first log on to the 
Service machine with a user who has the correct permissions to modify the Windows regis-
try. The Windows Registry can be accessed by going to the Start > Run... menu and exe-
cuting regedt32.

The following registry entries control the behavior of the Compoze Exchange Service. All 
of the following registry keys are located in HKEY_LOCAL_MACHINE\Software\Compoze 
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Software, Inc.\czex. If any of these registry entries are not created, you must first create 
them. When creating registry entries, be sure that the type is correct (next to the key name in 
the table below), otherwise the setting will drop back to its default value.

Key Description
Change Requires 
Service Restart?

AttachmentDirectory 
(REG_SZ)

The full path to the directory where attachments 
are temporarily stored while sending from IIS 
to the Compoze Exchange Service. The direc-
tory should be on a volume with sufficient disk 
space to store attachments while in transit. The 
exact amount of disk requirements will depend 
on the server load but choose a volume with at 
least a gigabyte of free space. If the directory 
does not already exist, then the Compoze 
Exchange Service will create it.

No

ClientVersionCheck 
(REG_DWORD)

If this entry exists and is set to 1 (the default), 
verify that the client version is the same as the 
service, otherwise do not allow sessions to be 
opened. NOTE: if you do not perform verifica-
tion that the versions are the same, you may run 
into compatibility issues between your Java 
code and the service.

Yes

GalDomain (REG_SZ) the domain of the fixed GAL user (required for 
lookups in Exchange 2000 and above)

No

GalMailbox (REG_SZ) the mailbox of the fixed GAL user (required for 
lookups in Exchange 2000 and above)

No

GalPassword (REG_SZ) the password of the fixed GAL user (required 
for lookups in Exchange 2000 and above)

No

GalServer (REG_SZ) the fixed Exchange server for the user to con-
nect to (required for lookups to work in any 
Exchange version)

No

GalUsername (REG_SZ) the username of the fixed GAL user (required 
for lookups in Exchange 2000 and above)

No
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InstallDir (REG_SZ) The installation directory of the Compoze 
Exchange Service. For example: c:\Program 
Files\compoze\czex. This is the 
%COMPOZE_EXCHANGE_SERVICE_HOME%.

No

LogComErrors 
(REG_DWORD)

If set to 0 (the default) do not log any normal 
COM exceptions that may occur during the 
course of execution. If set to 1 (useful for 
debugging) log all COM exceptions that occur 
to the Application Log in the Event Viewer.

No
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LogonType 
(REG_DWORD)

The chosen logon type performed in the ser-
vice:

0 = Interactive Logon 
(LOGON32_LOGON_INTERACTIVE). This 
requires that each user be granted the Windows 
“Log on Locally” right to the Compoze 
Exchange Service machine, but can connect to 
remote Exchange servers in the same domain or 
a trusted domain.

1 = Batch Logon 
(LOGON32_LOGON_BATCH). This requires 
that each user be granted the Windows “Log on 
as a Batch Job” right, but can connect to remote 
Exchange servers in the same domain or a 
trusted domain. This right may be added with-
out Log on Locally rights so that it disallows 
users from logging in interactively to the 
machine.

2 = Network Logon 
(LOGON32_LOGON_NETWORK). This does 
not require any special rights to be granted to 
users, but with this configuration the service 
MUST be installed on the same Exchange 
server that is being accessed.

3 = No Logon. With this logon type whatever 
user the service runs as will have to be able to 
access every account that needs to be accessed 
using the service. No user validation or logon is 
performed.

Yes

ProfilingEnabled 
(REG_DWORD)

If set to 1, log timing information for methods 
called in the Compoze Exchange Service to the 
event viewer. If set to 0 or if the key does not 
exist, do not log timing info.

Yes
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SessionTimeoutSecs 
(REG_DWORD)

If a session is idle for this number of seconds, it 
will be closed. This prevents the Compoze 
Exchange Service from having sessions open in 
memory that are no longer in use. The default if 
the registry entry is not specified is 1800 sec-
onds, or 30 minutes. The value of this setting 
will be re-read in no longer than one minute, so 
if it is changed from a large value to a small one 
for testing purposes, be sure to wait a minute 
for the change to take affect.

No

ServiceTerminateHours If the service has been running for this many 
hours, it will be terminated as soon as there are 
less than or equal to ServiceTerminateMax-
Sessions still open. This is useful for forcing 
a service restart on the given interval (for exam-
ple, 24 hours). The default is 0 (which means to 
never terminate the service).

WARNING: The service will only restart if 
you have selected this in the Recovery tab of 
the Windows service properties as described in 
“Maintaining Service Uptime” on page 2-8. 
Otherwise, this setting will force the service to 
terminate and it will not restart.

No

ServiceTerminateMax-
Sessions

When deciding whether or not to restart the ser-
vice, this setting is consulted to determine what 
the maximum number of sessions that can be 
open is. If 0 (the default) the service waits until 
no sessions are open to do a restart. If 5, for 
example, it will kick off up to 5 users in order 
to do a restart.

No

SoapEncryptionKey 
(REG_SZ)

If this parameter is supplied, the user password 
is encrypted with this key, even if SSL is not 
being used. A default key is chosen if it is not 
set. Be sure to supply the corresponding 
PROP_SOAP_ENCRYPTION_KEY property when 
instantiating the Session object on the client 
side, otherwise user logins will fail.

No
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The following registry entries control the behavior of the Microsoft SOAP Toolkit (and thus 
affect the Compoze Exchange Service). All of the following registry keys are located in 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSSOAP\30\SOAPISAP.

Global Address List Lookups
The Compoze Exchange Service can automatically look up the mailbox and/or home 
Exchange server for a user if they are not supplied when the session is opened. This is done 
by connecting to a fixed Exchange server and querying the Global Address List (GAL). The 
registry entries that control lookups begin with “Gal”. For more information, see “Manually 
Configuring the Registry Entries” on page 4-3.

If Exchange 5.5 is being used, the connection to the GAL can be anonymous and only the 
Exchange server must be supplied. Exchange 2000 and above requires that a separate 

Key Description
Change Requires IIS 
Restart?

MaxPostSize 
(REG_DWORD)

The maximum size that a client may post to IIS, 
in bytes. NOTE: this is not the maximum 
attachment size. The maximum attachment size 
is actually 4K or so less. This setting affects the 
size of any post, which could restrict the size of 
a large message body as well.

Yes

NoNagling 
(REG_DWORD)

If set to 1, disable the TCP Nagle algorithm. 
Nagling delays the sending of information until 
a certain amount of data is obtained. It is safe to 
leave this set to the default value of 0.

Yes

NumThreads 
(REG_DWORD)

The number of threads in the IIS pool available 
to handle requests. Any requests after the maxi-
mum pool size has been reached will be 
queued. The default is 3. In production, Com-
poze suggests a value that is 4 times the number 
of CPUs on the machine. For example, a dual 
CPU machine would have a NumThreads set-
ting of 8.

Yes

ObjCachedPerThread 
(REG_DWORD)

This is the number of objects (in our case 
WSDL files) cached per thread. It is safe to 
leave this at the default setting of 1.

Yes
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account and mailbox be available for the purpose of GAL queries. Note that for non-anony-
mous GAL connections the LogonType registry entry is used to determine what type of 
Windows impersonation is done in the service, so the GAL user must have sufficient rights 
to access the Compoze Exchange Service machine as defined by the rights in LogonType.

Proxy Servers
In order to connect to a Compoze Exchange Service through an http proxy server. The fol-
lowing Java system properties may be set to control the proxy connection (notice that they 
are the same as the Java system properties that are used except they are prefixed by the 
string “czex”):

Domino Service Connection 
To verify that you can open a connection to the service and that the service can connect to 
Domino, use the Domino Connection Portlet.

Java System Property Description

czex.http.proxyHost the hostname of the proxy server

czex.http.proxyPor the port of the proxy server

czex.http.proxyUser the username to access the proxy server

czex.http.proxyPassword the password to access the proxy server
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Connecting to Domino via the Compoze Domino Service
1. Select the Domino Service Connection option from the Welcome page of the Compoze 

Administration Portlet.
2. Enter the required connection information. A detailed description for each parameter is 

listed in the table below.
3. Once the required information is entered, click the “Connect” button.
4. If you can connect successfully, you will be given the option of obtaining more informa-

tion for the mailbox specified by clicking the continue button. This will test common 
calls to the service such as getting the number of messages from the Inbox.

5. Click the “End Diagnosis” button at any time to start over.

Field Description

Domino Service URL or host name In this field, specify the location of the Compoze Domino Service 
server using one of the following forms:

• hostname - the hostname of the server

• hostname:port - the hostname and port of the server

• protocol://hostname/ - the protocol and hostname of the server

• protocol://hostname:port/ - the protocol, hostname and port of 
the server.

In all the cases above you can use the IP address instead of the host-
name. For any of the above forms which take a hostname, the name 
must be resolvable by this machine. You can test this on Windows 
or Unix machines by running the ping command from the command 
shell. 

Other defaults: protocol=http and port=80.

Username In this field, specify the username of the user that's accessing the 
Domino mailbox. This is not the name of the Domino mailbox 
(which may or may not be different), but the name of an user.

Password In this field, specify the password of the user that's accessing the 
Domino mailbox.
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Domino Service Configuration
As a system administrator, you will be able to configure the Compoze Domino Service. The 
configuration can be performed either manually (on the Compoze Domino Service 
machine) or by using the Compoze Domino Administration Portlet.

Domino Server (Catalog Host 
Name)

In this field, specify the name of the Domino server, as resolvable 
from the Notes domain machine. This could just be a Domino server 
name, such as domino Server/Domain and will be used to lookup the 
specified user to determine the name and location of the user's mail-
box.

Domino Mailbox In this field, specify the mailbox or alias of the mailbox that you are 
trying to access on the Domino server. This can be the same as the 
username, but this does not have to be. The specified username must 
have ACL access to this mailbox. If you are unsure, leave blank to 
connect to the mailbox of the specified user from before.

Proxy Server Host Name The hostname of the proxy server

Proxy Server Username The username to access the proxy server

Proxy Server Password The password to access the proxy server
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Configuring the Compoze Domino Service
1. Select the Domino Service Configuration option from the Welcome page of the Admin-

istration Portlet.
2. Enter the required Domino Service URL or host name. This value is the same as the 

Domino Service URL entered in the DominoServiceConnection Portlet.
3. Once the required information is entered, click on the “View Configuration” button.
4. If you can connect successfully, you will be given the option of obtaining the current 

configuration information and modifying the settings by clicking on the Continue Con-
figuration button.

5. A detailed description for each parameter is listed Manually Configuring the Regis-
try Entries section below.

6. Configure the information by modifying the desired data, and click the “Configure Ser-
vice” button.

Note: Some of the parameters will require a restart of the Compoze Domino Service or the 
Domino Server to take effect. These parameters are identified in the Portlet.

Manually Configuring the Domino Configuration Settings
To manually configure the Compoze Domino Connector Service, you will need to first log 
on to the Service machine as a Lotus Domino Administrator. The following database entries 
control the behavior of the Compoze Domino Service. All of the following entries can be 
found in the czdo_config.nsf database found under the Lotus Domino Data directory.

Key Description
Change Requires 
Service Restart?

Licensee The company or user name that the service was 
licensed to. This is required for a production 
license.

Yes

ServiceKey The license key for the service. This value 
works in conjunction with the Licensee. This is 
required for a production license.

Yes

Attachment Size Limit The maximum attachment size limit (in bytes). Yes
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BEA User Profile Data
You can obtain more information about the BEA User Profile information that is being 
accessed by the Groupware Portlet by selecting the Portal User Profile Management 
option from the Welcome page.

Attachment Temp Direc-
tory

The full path to the directory where attachments 
are temporarily stored while sending from the 
Domino Server to the Compoze Domino Ser-
vice. The directory should be on a volume with 
sufficient disk space to store attachments while 
in transit. The exact amount of disk require-
ments will depend on the server load but choose 
a volume with at least a gigabyte of free space. 
If the directory does not already exist, then the 
Compoze Domino Service will create it.

Yes

Session Timeout If a session is idle for this number of seconds, it 
will be closed. This prevents the Compoze 
Domino Service from having sessions open in 
memory that are no longer in use. The default if 
the registry entry is not specified is 1800 sec-
onds, or 30 minutes. The value of this setting 
will be re-read in no longer than one minute, so 
if it is changed from a large value to a small one 
for testing purposes, be sure to wait a minute 
for the change to take affect.

Yes

Log Level The log level can be set to one of the following:

• Error

• Warning

• Info (default)

• Debug

Yes
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Obtaining the BEA User Profile information
1. Select the Portal User Profile Management option from the Welcome page of the Com-

poze Administration Portlet.
2. Enter the BEA Portal user name that you would like to access the User Profile informa-

tion for.
3. Once the required information is entered, either click the “View” button or the “View 

Preferences” button.
4. Clicking on the View Accounts button will display all of the accounts that are set up for 

the specified user. You can then access more information about each account by clicking 
on the account name. If a user is having issues with a specific account, you can delete 
this information and have them re-enter the information into the Groupware Portlet.

5. User Preferences are not tied to one account so are set globally. You can access all of the 
Groupware Portlet preferences for a specified user by click on the “View Preferences” 
button.

6. Click the “End Diagnosis” button at any time to start over.
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CHAPTER 5 Groupware Portlet
The Groupware Portlet is a Java Page Flow Portlet that uses Portlet Preferences to control 
some of the behavior associated with each logical portlet instance. A number of default 
Portlet Preferences have been defined in the CompozeGroupware.portlet file. There are addi-
tional Portlet Preferences which can be added to specific instances of the Portlet when con-
figuring the portlet via the WebLogic Administration Tools Portal. This section describes 
the Portlet Preferences associated with the Groupware Portlet which used to configure vari-
ous capabilities such as features and navigation.

Groupware Portlet Definition
The Groupware Portlet ship with a .portlet file found at:

%COMPOZE_PORTLETS_HOME%\portlets\compoze\CompozeGroupware.portlet

The Content URI and otional Edit URI are as follows:

Property Description Value

Content URI This property is the location of the 
content page flow JPF class.

/portlets/compoze/content/con-
tentController.jpf

Edit (optional) This property is the location of the 
edit page flow JPF class (optional).

/portlets/compoze/content/edit/
editController.jpf
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Portlet Preferences

Feature Groups

For each logical Portlet instance, the active features can be configured. By default, all fea-
tures are active. By modifying, these preferences, a Portal Administrator can deploy multi-
ple logical instances of the Groupware Portlet and configure which feature(s) is available in 
each instance. The following preferences can be found in the CompozeGroupware.portlet file 
and can altered by either modifying the CompozeGroupware.portlet or by configuring indi-
vidual Portlet instances while using the WebLogic Administration Tools Portal.

Preference Description Values

groupware.feature.address_book This preference activates the address book 
feature.

true/false

groupware.feature.calendar This preference activates the calendar fea-
ture.

true/false

groupware.feature.mail This preference activates the mail feature. true/false

groupware.feature.tasks This preference activates the tasks feature. true/false

groupware.feature.options This preference activates the options feature. 
NOTE: if this feature is disabled, users will 
have no way of accessing the options feature 
unless the Edit mode has been enabled for the 
portlet.

true/false

groupware.feature.home This preference activates the home feature. 
NOTE: if this feature is disabled, users will 
have no way of accessing the home and sum-
mary pages. User will be immediately for-
wared to the full view of an enabled feature.

true/false
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To enable the instant messaging feature, the following Portlet Preference must be added to 
individual instances of the Groupware Portlet via the WebLogic Administration Tools Por-
tal.

Maximized View Feature Title and Navigation

Each page in the Groupware Portlet includes a title (also referred to as a “header”) at the 
top. A portal administrator can optionally configure to display this title and if the title is dis-
played, can configure how navigation is used within the title. Note that all pages in maxi-
mized view of the portlet include the same JSP which is used to display the feature title and 
navigation. The following preferences determine if the title is displayed for each feature. By 
default, feature titles are enabled. To disable individual feature titles, the following Portlet 
Preference must be added to individual instances of the Groupware Portlet via the 
WebLogic Administration Tools Portal and configured to be false.

Preference Description Values

groupware.fea-
ture.instant_messaging

This preference activates the instant messag-
ing feature. By default, this feature is inac-
tive.

true/false

Preference Description Values

groupware.fea-
ture.address_book.title

This preference activates the titles for the 
address book feature pages.

true/false

groupware.feature.calen-
dar.title

This preference activates the titles for the cal-
endar feature pages.

true/false

groupware.feature.mail.title This preference activates the titles for the 
mail feature pages.

true/false
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The title can be configured to support options navigation or features navigation. Options 
navigation provides a link to the feature options configuration in the title. Features naviga-
tion provides links to the features of the Groupware Portlet. This preference can be found in 
the CompozeGroupware.portlet file and can altered by either modifying the CompozeGroup-
ware.portlet or by configuring individual Groupware Portlet instances while using the 
WebLogic Administration Tools Portal.

Each page in the Groupware Portlet also includes a navigation area (also referred to as a 
“left navigation area”) at the left side of the portlet. A portal administrator can optionally 
configure to display this navigation area. Note that all pages in maximized view of the port-
let include the same JSP which is used to display the left navigation area. The following 
preference determines if the left navigation area is displayed for all features. By default, the 
left navigation area is disabled. This preference can be found in the CompozeGroupware.port-
let file and can enabled by either modifying the CompozeGroupware.portlet or by configur-
ing individual Groupware Portlet instances while using the WebLogic Administration Tools 
Portal.

groupware.feature.tasks.title This preference activates the titles for the 
tasks feature pages.

true/false

groupware.fea-
ture.options.title

This preference activates the titles for the 
options feature pages.

true/false

Preference Description Values

group-
ware.title.feature_navigation

This preference configures the titles to use 
feature navigation. In order for feature navi-
gation to be enabled in the Groupware Portlet 
title section, feature titles must be configured 
to be visible in features where title feature 
navigation will be available.

true/false

Preference Description Values

groupware.left_area This preference activates the left navigation 
area for all maximized feature pages.

true/false
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Home View Feature Navigation

Each summary page in the home view of the Groupware Portlet includes two navigation 
areas: a navigation area (also referred to as a “top navigation area”) at the top and bottom 
(also referred to as a “bottom navigation area”) of the page. A portal administrator can 
optionally configure to display the top or bottom navigation areas. Note that even though 
the two navigation areas can be displayed simultaneously in two different sections areas of a 
summary page, it is the same JSP page which is optionally included in the both the top and 
bottom areas of the page. 

The bottom navigation area preference can be found in the CompozeGroupware.portlet file 
and can altered by either modifying the CompozeGroupware.portlet file or by configuring 
individual Groupware Portlet instances while using the WebLogic Administration Tools 
Portal.

To enable the top navigation area, the following Portlet Preference must be added to indi-
vidual instances of the Groupware Portlet via the WebLogic Administration Tools Portal 
and configured to be true.

If the top or bottom navigation is enabled in the home views, links will be available for each 
enabled feature, except Options, which will allow a user to access the Home view of a fea-
ture from the Home navigation area. To disallow users from accessing Home views for fea-
tures, the following Portlet Preference must be added to individual instances of the 

Preference Description Values

groupware.feature.home.naviga-
tion.bottom

This preference activates the bottom naviga-
tion area for home pages.

true/false

Preference Description Values

groupware.feature.home.naviga-
tion.top

This preference activates the top navigation 
area for home pages.

true/false
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Groupware Portlet via the WebLogic Administration Tools Portal and configured to be 
false.

Error Reporting

The Groupware Portlet includes specialized areas for handling various error and exception 
scenarios which may occur in the Groupware Portlet. Depending on the type of error that 
occurred, the Groupware Portlet may forward to a pageflow which was designed to handle 
that specific error scenario or to a pageflow which is meant to handle more general types 
errors. If a general error occurs, the Groupware Portlet will forward to the compoze\con-
tent\error\general pageflow. With the default configuration of the Groupware Portlet, 
general error display page will include an area where a stack trace of the exception that 
occured can be viewed. To configure the Groupware Portlet not to show the exception stack 
trace on the error page, the following Portlet Preference must be added to individual 
instances of the Groupware Portlet via the WebLogic Administration Tools Portal and con-
figured to be false. 

Preference Description Values

groupware.feature.home.naviga-
tion.min

This preference activates the links for fea-
ture home pages in the home navigation 
area.

true/false

Preference Description Values

groupware.error_stacktrace This preference hides the area where an 
exception stack trace can be viewed for 
error pages.

true/false
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CHAPTER 6 Customizing the Groupware Portlet
This section describes the Customization features associated with the Groupware Portlet. 
The look and feel of the Groupware Portlet can be customized by modifying the Cascading 
Style Sheet (CSS) Class properties. The behavior of the Groupware Portlet can be custom-
ized by modifying the Groupware ‘Listener’ classes.

Skins

The Compoze Portlets reference custom CSS Class names that are located in a file named 
compoze.css. Different versions of this file can exist for each skin in the Portal. Display 
aspects such as the font, background color, and text position can be easily modified by 
changing the properties inside the CSS class definitions.

The compoze.css file is organized into eight logical groups:

• General CSS resources (used by any portlet utilizing these HTML features)
• General Compoze (used by multiple feature groups)
• Addressbook Feature Group
• Calendar Feature Group
• Home Feature Group
• Mail Feature Group
• Options Feature Group
• Tasks Feature Group

Listener Classes

The Listener classes are located user the %PORTAL_PROJECT%/compoze/groupware/c13n/ 
directory. A default implementation exists for each Listener class. By modifying these 
classes, or creating your own implementation, you can change the following:
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• How the portlet obtains provider account information
• Where portlet events are logged
• How the portlet interacts with the user from page to page.

Account Listener

The AccountListener interface represents an interface for receiving account events. The 
DefaultAccountListener class represents a default implementation of the AccountLis-
tener interface. The DefaultAccountListener uses BEA’s User Profile capabilities to 
retrieve and store provider account information. This class can be extended to:

• Configure the type of provider to which new accounts will be bound to
• Acquire provider connection parameters to providers from a source other than the BEA’s 

User Profile
• Pass additional connection parameters to the provider
• Configure whether certain connection parameters are required to be entered during 

account setup
• Configure whether multiple accounts can be added in the portlet
• Configure whether users have the ability to add or edit accounts
• Automatically create Groupware accounts for users
• Configure SSO.

To configure the portlets to use the subclass of the DefaultAccountListener which you 
have created, alter the DefaultAccountListener’s getAccountListener method to return 
a new instance of your custom AccountListener. Various implementations of the Accoun-
tListener interface, such as ExchangeAccountListener and DominoAccountListener, ship 
with the product to aid you in the creation of your own custom AccountListener implemen-
tation.

Log Listener

The LogListener interface represents an interface for receiving log events. The Default-
LogListener class represents a default implementation of the LogListener interface. The 
DefaultLogListener currently does nothing so the log information is sent to the logging 
mechanism set for the BEA Portal. This messageReceived() method of this class can be 
altered to (for example):
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• Log information to additional targets (e.g. a database or file)
• Perform logging based on some type of constraints.

The portlet logging mechanism is sensitive to the logging level configured on the host 
WebLogic Portal. Debug and other messages can be output to the logging targets by altering 
the Logging Severity Threshold on the server to “Info”.

View Listener

The ViewListener interface represents an interface for receiving view events. The 
DefaultViewListener class represents a default implementation of the ViewListener 
interface. The DefaultViewListener maximizes every view except those originating from 
the Home feature. By modifying this file, the Groupware Portlet can be displayed in the 
Normal mode, Maximized mode, or any combination of the two.

Portlet Locales

The LocaleUtility class is located under the %PORTAL_PROJECT%/compoze/groupware/
c13n/ directory. The default list of locals can be modified by altering the list of available 
locales in the s_supportedLocales. If additional locales are added, be sure to add proper-
ties files which correspond to the list of new locales which will be available in the portlet. 
The list of properties files which should be created is:

• %PORTAL_PROJECT%/compoze/content/
groupware_resources_%JAVA_LOCALE_NAME%.properties

• If the instant messaging feature is enabled, add a %PORTAL_PROJECT%/compoze/content/
compoze_portlets_im_resources_%JAVA_LOCALE_NAME%.properties

• If the domino provider is being used, add a 
domino_resources_%JAVA_LOCALE_NAME%.properties file in the top-level directory 
of all harmony_portlets.jar files. 

• If the exchange provider is being used, add a 
exchange_resources_%JAVA_LOCALE_NAME%.properties file in the top-level direc-
tory of all harmony_portlets.jar files. 

Note: If you encounter exceptions that include the following text, the properties files you 
have created are missing properties and should be altered to contain all properties that the 
default and unmodified groupware_resources.properties file contains. For example, 
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the error: Error opening /portlets/compoze/content/addressbook/addContact/
add_contact.jsp. The source of this error is javax.servlet.ServletExcep-
tion: Can't find resource for bundle com.bea.p13n.taglib.i18n.JspMessage-

Bundle, key contacts.contact_add.button.attach means that the 
“contacts.contact_add.button.attach” key is missing from the 
groupware_resources_%JAVA_LOCALE_NAME%.properties file.
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CHAPTER A Manual Installation
The Compoze Portlets installer automatically copies the portlet JSP files, portlet definition 
files, and the harmony_portlets.jar in place. These files are copied to directories under 
the %PORTAL_APPLICATION% directory. The installer also modifies the web.xml to add neces-
sary Servlet mappings for the Compoze Portlets.

The following procedure shows you how to do these steps manually.

Copying the Compoze Portlets into place
1. Navigate to %COMPOZE_PORTLETS_HOME%\portlets and copy the compoze folder and 

all its contents. 
2. Paste the compoze folder into the following directory:

%PORTAL_PROJECT%\portlets

Copying the CSS and image files into place
1. Navigate to %COMPOZE_PORTLETS_HOME%\skins\avitek\css and copy the compoze.css 

file.
2. Paste the compoze.css file into the following directory:

%PORTAL_PROJECT%\framework\skins\avitek\css

3. Navigate to %COMPOZE_PORTLETS_HOME%\skins\avitek\images\ and copy the compoze 
directory.

4. Paste the compoze directory into the following directory:
%PORTAL_PROJECT%\framework\skins\avitek\images

Note: Avitek is a skin that ships with the sample portal. This skin may not exist on your por-
tal. Copy the compoze.css and images files into the all of the skins that are configured for 
your environment.
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Copying the harmony_portlets.jar into place
1. Navigate to %COMPOZE_PORTLETS_HOME%\lib and copy the harmony_portlets.jar file.
2. Paste the harmony_portlets.jar file into the following directory:

%PORTAL_APPLICATION%\APP-INF\lib

Modifying the web.xml file
1. Navigate to %PORTAL_PROJECT%\WEB-INF\
2. Open the web.xml file with a text editor.
3. In the Servlet section, add the following:

<servlet>
<servlet-name>CompozeGroupwareAttachmentServlet</servlet-name>
<display-name>CompozeGroupwareAttachmentServlet</display-name>
<description>Compoze Groupware Attachment Servlet</description>
<servlet-class>portlets.compoze.groupware.AttachmentServlet</servlet-class>
</servlet>

<servlet>
    <servlet-name>CompozeGroupwareEmbeddedImageServlet</servlet-name>
    <display-name>CompozeGroupwareEmbeddedImageServlet</display-name>
    <description>Compoze Groupware Embedded Image Servlet</description>
    <servlet-class>portlets.compoze.groupware.EmbeddedImageServlet</servlet-
class>

</servlet>

<servlet>
    <servlet-name>CompozePortletsImServlet</servlet-name>
    <display-name>CompozePortletsImServlet</display-name>
    <description>Compoze Portlets Im Servlet</description>
    <servlet-class>portlets.compoze.im.tags.ImServlet</servlet-class>
</servlet>

4. In the Servlet Mapping section of the same web.xml file, add the following:
<servlet-mapping>
    <servlet-name>CompozeGroupwareAttachmentServlet</servlet-name>
    <url-pattern>*.compozegroupwareattachmentservlet</url-pattern>
</servlet-mapping>

<servlet-mapping>
    <servlet-name>CompozeGroupwareEmbeddedImageServlet</servlet-name>
    <url-pattern>*.compozegroupwareembeddedimageservlet</url-pattern>
</servlet-mapping>

<servlet-mapping>
    <servlet-name>CompozePortletsImServlet</servlet-name>
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    <url-pattern>*.compozeportletsimservlet</url-pattern>
</servlet-mapping>

5. In the Tag Library definition section of the same web.xml file, add the following:
<taglib>
    <taglib-uri>compoze-portlets-im.tld</taglib-uri>
    <taglib-location>/WEB-INF/compoze-portlets-im.tld</taglib-location>
</taglib>

Copying the compoze-portlets-im.tld into place
1. Navigate to %COMPOZE_PORTLETS_HOME%\web directory and copy the compoze-

portlets-im.tld file.
2. Paste the compoze-portlets-im.tld file into the following directory:

%PORTAL_PROJECT%\WEB-INF

Copying the compoze_portlets_im_resources.properties into place
1. Navigate to %COMPOZE_PORTLETS_HOME%\web\classes directory and copy the com-

poze-portlets-im.tld file.
2. Paste the compoze_portlets_im_resources.properties file into the following direc-

tory:
%PORTAL_PROJECT%\WEB-INF\classes
Compoze Portlets Setup Guide A-3



CHAPTER B Known Issues and Workarounds
This document includes known issues for the Compoze Portlets 2.5 release. This document 
is subject to change without notice.

Requires WLP 8.1 SP2 (GA not supported)

This is due to an issue with Page Flows, where form validation is only available (or work-
ing) in SP2.

JavaScript Patch (SP2 only) required

If running in streaming mode, need BEA WebLogic Portal patch patch_CR135264.zip.

In a clustered portal environment, the following patches are needed for 
failover to succeed (SP3 and earlier)

• patch_CR189705_81SP3

• issue resolved: form members (e.g. dropdowns, checkboxes, radio buttons, etc...) 
with multiple values failover as null.

EAR fails to deploy due to path name length limitation

EAR fails do deploy on Windows if the application/project/domain path name is too long.

Refer to http://e-docs.bea.com/wlp/docs81/deploy/deploy.html#1003589.
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Secure port (HTTPS) in Standalone Page Flows does not work (SP2 
only)

Page Flows that are deployed standalone in a portal application cannot use a {url:secure-
Port} token defined in url-template-config.xml. In this context, a ‘standalone’ page flow 
means one that is deployed in a portal project, is accessed directly, but is not aggregated in a 
portal page. The {url:securePort} token works only when a page flow is aggregated in a 
portal page. A standalone page flow in a portal cannot use:

https://{url:domain}:{url:securePort}/{url:path}?{url:queryString} url:securePort

The work around for standalone page flows in portals is to hard code the ports in url-tem-
plate-config.xml, instead of using the token {url:securePort}.

Refer to http://e-docs.bea.com/workshop/docs81/relnotes/relnotes.html.

Portlet Preferences being reset after server is restarted

Add the following code to your netui-config.xml file:
<customization>
     <enable>true</enable>
     <propagate-preferences-on-deploy propagate-to-instances="false"/> 
</customization>

This can also occur if the portal server is not shut down gracefully.

Calendar (Exchange Provider)
Create a meeting request, enter CJK characters into the description. The invitee who 
receives the meeting requests sees the body as question-marks. This is due to a CDO limita-
tion.

Address Book/Contacts
When Adding/Editing a Contact, the types and order of name titles (Mr., Mrs., etc.) and 
Name suffix (I, II, II etc.) are not culturally appropriate way for French, German, or Japa-
nese.
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Name order is not locale-sensitive in Contacts.

Address order is not locale-sensitive in the Address book.

Contacts are not sorted in a culturally appropriate way for French, German, or Japanese.

Clicking on a page before it has loaded in the browser can lead to error

Description: If user clicks on a page before it has finished loading, a NullPointerException 
can be produced in the portlet.

Workaround: Before clicking in the Compoze Portlet, wait until the page has fully loaded in 
the browser.

Using the "Back" button in the browser can lead to error in portlet

Description: Clicking the "Back" button in the browser can lead to an “Action not found” 
error in the Compoze portlet. The error may appear after clicking the back button. If the pre-
vious page successfully loads in the browser, links or buttons may also produce the “Action 
not found” error. If the action that is requested to be executed after the “Back” button was 
clicked existed in a parent or nested pageflow, and does not exist in the current page flow, 
the error will be produced.

Workaround: Wait until the Compoze Portlet has finished processing and the page has been 
fully loaded into the browser.

Messages which contain "BASEHREF" tags in bodies may cause 
HTML to display incorrectly

Description: Messages which contain "BASEHREF" tags in bodies may cause HTML to 
display incorrectly.
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Refresh Action specified in CompozeGroupware.portlet file may not 
work on SP2

Description: The CompozeGroupware.portlet specifies a “refreshAction”. The SP2 version of the 
portal has a known issue where this action may not be properly excecuted. This issue was 
resolved with the SP3 version of the portal. Please refer to http://e-docs.bea.com/workshop/
docs81/relnotes/relnotes.html, CR174636 for more information. Patches CR129301 and 
CR174636 to resolve the issue, but installation of the SP3 version of the portal is highly rec-
ommended. The refresh action is triggered when the portlet reloads, and is most important if 
multiple instances of the portlet are deployed on the same desktop. If the refresh action is 
removed, and the “EDIT” mode of the portlet is enabled, and the user returns to “NORMAL” or 
“MAXIMIZED” mode of the portlet, the new preferences may not take because the portlet has 
not refreshed. As a workaround the refresh action (in bold) can be removed from the Com-
pozeGroupware.portlet file. It is also recommended that users access the Options section of the 
portlet via the “Options” feature, rather than by entering the “EDIT” mode of the portlet.

Removing the refreshAction from the .portlet file: 

Alter the following code in your CompozeGroupware.portlet file

• from:
<netuix:content>
<netuix:pageflowContent contentUri="/portlets/compoze/content/contentControl-
ler.jpf" refreshAction=”refreshAction”/>

</netuix:content>

• to:
<netuix:content>
<netuix:pageflowContent contentUri="/portlets/compoze/content/contentControl-
ler.jpf"/>

</netuix:content>
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Known Issues and Workarounds
When multiple portlet instances are shown, switching accounts and 
then clicking on an item in a portlet instance which has not refreshed 
can cause error

Description: With separate portlets configured in mini-views, switching accounts then 
accessing items in other portlets can cause errors.

Resolution: see “Refresh Action specified in CompozeGroupware.portlet file may not work 
on SP2” on page vii

Japanese and Accented characters may cause error in spell checker

Description: When a Japanese or accented character is encountered the spell check stops 
and the dialog displays in English "An error has occurred".

Some popup windows may be smaller than the information that is 
being displayed in the popup when using NS7.1 and Mozilla 1.3

Description: When using NS7.1 and Mozilla 1.3, the size of the popup may not be large 
enough to accommodate for the HTML that has been generated into the popup window.

Some messages which contain very long strings in the body or subject 
may cause the portlet page to become very wide when the message is 
read.

Description: Some messages which contain very long strings in the body or subject may 
cause the portlet page to become very wide when the message is displayed in “Read Mes-
sage” mode. For example, a long, uninterrupted string (i.e. 
aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa)will cause the portal page 
to be very wide
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